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CeroAHs MBI OOCYAHIM:

UTO Takoe KOHCTPYKTOP MHTEPAKTUBHbIX
yrpaXHEeHUN @ Hot Potatoes-

Kakne ynpaxxHeHuUs Mbl MOXXeM cO34aBaTh
camu

Kak nameHunTb gu3aviH ynpaxHeHuu
Kak ncnonb3oBatb Hot Potatoes B kypcax

Thoodle

,D,J'IFI Yero Hy>XHbl KaPTOLIKN — BbIBO/ - ?



Ymo Ber snaeme o npozpavime ¢

Hot Potatoes-

From Half-Baked Software Inc




Umo 6561 Bbi
xomenu
y3Hamb
Ce200HSA ?




Y10 Takoe KOHCTPYKTOP MHTEPAKTUBHBIX
yrrpaxkaeani Hot Potatoes?

becnnaTtHaa nporpamma

[lo3BoNgAeT co3gaBaTb S BUOOB
yrpaKHEHUU

[locTynHa anga ckadmBaHu4
http://hotpot.uvic.ca/
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‘J Cloze — 3ammoAHeHNE ITPOITYCKOB

Index | =>

Gap-fill exercise

Fill in all the gaps, then press "Check" to check your answers. Use the "Hint" button to get a free letter if an answer is giving you trouble. You can also click on the "[?]" button to get a clue.
Note that you will lose points if you ask for hints or clues! Please DO NOT USE CONTRACTIONS (i.e. don't)

1. fyou (be) late again, | (not let) you come in.

2. You (can) stay at your friend's till 10 p.m. unless they (object).

3. fwe (not to hurry), we (be) late!

4. In case you (to have) any problem, | (try) to help you.

5 1t (be) nice, if you (be able to come) to the party.

6. My mother (come) as soon as she (have) some spare time.

7.1t (be) easier when we (book) a hotel.

8. If you (drive) very fast along a slippery road, you will definitely have (definitely have) an accident.
9.1 (finish) this exercise before my classmates (do).

Check | Hint |




‘J Quiz — TecT (BApHAHTHI OTBETOB)

Your score is 100%.
Questions completed so far: 1/35.

Show questions one by one

1. It often ... in autumn.

A2 | i
B - | rains
C ;] eireiving
D. 2 |wilin

2. Ifhe ... tomorrow, we will not go to the country.

Az 2 |is busy




J Match — mpaxokA€HTE COOTBETCTBHA




‘] MixX — BOCCTAHOBAEHHUE TEKCTA
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JOBS MIXED WORDS QUIZ

Mixed-up sentence exercise

Putthe parts in order to form a sentence. Ywhen you think your answer is correct, click on “"Check to check your answer. If you get stuck, click on "Hint" to find out
the next correct part.

| have because

Undo | Restart | Hint |

. children like working after | look to two flexitime

T o]




J Cross - KpoccBOPA

Index =>

Crossword

Complete the crossword, then click on "Check” to check your answer. If you are stuck, you can click on "Hint" to get a free letter. Click on a number in the grid to see the clue or clues for
that number.

Across: 8: the title of the text you had to read before doing this exercise NUMBERSYSTEMSOFM  Enter l Hint |
Down: 8: the oldest and purest branch of mathematics (phrase - write without spaces) Enter | Hint

FM]A

|
||
TIHIS
|
|
|
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Hot Potatoes: VerkioH s
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Aasaiite meup KapTOoriky!!l

OTKpoUTE nporpammy Ha CBOEM
KOMMbIOTEPE.

«KNMNMKHNTE» Ha «KapPTOLLKY» |
Cross



‘ KAukamTe HA 3HAYOK «BOAITICOHAS ITAAOYKAY

JCross: [Untitled] l:—' l =] 3R J
File Edit Insert Manage Grid Options Help —_—

pecHBOo®Y | - smel W) ® | 2

] - U0 RN WY PN ORI U NSNS fo— { ) ST RSP Y W—
Create a crossword grid automatically l=[=] = |

Enter each word or phrase on a
separate line:

a “\ Make the grid |

Number of words
used in best
result so far: Of 0

-

Maximum grid size: |20 3: Stop now -- that's good enough

\Config: english6.cfg W




3AIUIITNTE HECKOABKO ITPOCTBIX CAOB
HAKMUTE KHOIIKY «make the grid»

JCross: [Untitled] |l == 2R
File Edit Insert Manage Grid Options Help

aecEHBRISSE|Y | L ma | | W | 2 |

I L. 1 L " 1 " " " " 1 " " L " I ] 1 7 I "
Create a crossword grid automatically LGM

Enter each word or phrase on a

sepgrate line:
) \

KOMNbHTEP ? “ Make the grid
WHTEPHEeT  —

Knaeuwatypa

MOHWUTOP Number of words
used in best
result so far: 0}'0

Maximum grid size: |20 Stop now -- that's good enough

|Config: english6.cfg 4




‘ (3araaBbTe KPOCCBOPA
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‘ Aob6asnm Borrpoce! — «Add Cluesy

—3aII1caB BoIIpoc, Haxxmute OK
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[TopaboTaeM ¢ BHEIITHIM BHAOM
Haxxmute Options -> Configure output -> Appearance
IIO3KCIEPUMEHTUPYITE C IIBETOM!

He 3a0yapTe HaxaTe OK

I

| Borbatebmioa® Srbefriess:
File Edit Insert Manage Grid Options Help
pecedBRSE|Y | > -a | #H | W | 2 |
| Title V Configuration file: C:\Program Files\HotPotatoes6\englishb.cfg Lilgl—zg,'
- Undo Insert
KpoccBopAa Tltles/lnstructions' Prompts/FeedbackI Buttons Appear Liser
2 OcHoBHble useTa:
Background graphic URL: _
Output font face: IGeneva | I AlE B B |
OQutput font size: Ismall - = - - = - - -
’ | o 8 0 0 B B |
=, Add Clues BN BN BN BN BN .
| eeesm | 0 0 8 &8 it I
Title
Navi 3
Text text text text text text text text text text av'j HogomMremiie thea:
text text text text text text text text text Page b il 8 B B B B B | — =
TTEHOK: aCHBIA:
L B B R B B B B |
. KontpacT:|210  3enenont: |250
Exercise b | Onpegenurs USeT l UseTi3anmexa ﬂpKoc'rb:IZOZ Cm-mﬁ:|180
Link SR OK | Otmena | No6asuts B8 Habop |
[& Preview I Text colour: [#000000 =

|Config: english6.cfg

|Grid size: 10 x9
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‘ Uyaeca cBouMH PyKaMH — HAKMHUTE 3HAYOK «O»

32TEM «COXPAHUTDHY) U «IIOKA3ATH («View. . .»)
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-’@E»Ell@l@@-i' | % BB | # | ®» | 2 |

Tite | [MNABMATYPA]
KpoccaoPA M O H _14 AT &o AP " " " I I " " " " I I " - |
M | View or upload the exercise LEIM
e following file(s) have been created:
b “ The following file(s) have b d
’e) [ r C:\Users\Hagexpaa\Desktop\kpocceopa htm
E I
A Add Clues E | What would you like to do?
P l
sl |- ]
< > | |~ %]l Upload the file to the hotpotatoes.net Website |
v r X Nothing |
|
[ ? Help

|Config: english6.cfg |Grid size: 10 x9 2




[ToAayammaoce?

KpoccBopA

Crossword

Complete the crossword, then click on "Check” to check your answer. If you are stuck, you can click on "Hint" to get a free letter. Click on a number in the grid to see the clue or clues for that
number.




YrpaBAeHUE AU3AHHOM

Bknagka Options -> Configure Output no3sonser:
N3ameHnTb nHcTpykuunn (Titles/Instructions)

N3MEeHUTb «noacKkaskn» u oTpegakTMpoBaTh
«peakuuto» Ha oTeeTbl (Prompts/Feedback)

N3aMeHUTb UBET ynpaXHeHus, poHa, Hagnuceu
(Appearance)

BkrtounTtb Tanmep, 4obaBmnTb AONONMHUTENbBHbIE
doyHkuunm (Timer, Other)

Bknagka Insert -> Picture no3BonseT BCTaBUTb
PUCYHOK N3 dpamna, B HEKOTOPLIX YNpPaXKHEHUNAX
TaKKe eCTb BCTaBKka MeanaganoB, CCbINOK.



KAKUE TNPENMMYLLECTBA (HEQOCTATKN?)
Bbl BUOWNTE B rPOIrPAMME

Hot Potatoes?

- Kak pa3pabomyuk

- Kak npernoodasamersib




| IpemmyiiecTBa mporpaMMBr AAA
Pa3padOTINKA YIPAKHEHIH

He TpebyeT 3HaHUA S3bIKOB
nporpamMMmpoBaHuUS

MHTYNTUBHO NOHATHbLIN UHTEPMENC
LLInpokmne BO3IMOXXHOCTU N3SMEHEHUA OANU3aMHa
B0O3MOXHOCTb UCMOMNb30BaTbh N300paXXeHns n
3BYK

CoBmecTtumocTtb ¢ Moodle

?°0°7?
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IIPETIOAABATEASA

icnonb3oBaHWe «KapTOLLEKY:
[loBbILLAET MOTUBALUIO
OnNTUMU3NPYET NpoLiecc odbyyeHuns

YnpoLlaeT npoBepKy
?7°?



« [lonb3yemecsk nu Bel LMS
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= Milcrnionb3yeme iU Bkl
ariemMmeHm Kypca Hoft
Potatoes Quiz?




Coszaanne snemenTa kypca «Hot Potatoes Quizy

OTtkpbiBaem kypc B Moodle
B pexxnme pegaktupoBaHUS

[HobaBuTb anemeHT Kypca -> Hot Potatoes Quiz
Boibnpaem nnu sarpyxaem dpauvn (.htm!l)
Penaktnpyem cpoku, MeEToA OLeHUBaHUA.
CoxpaHsaem
YnpaxHeHue 3arpyxeHo!!! ©



‘ 3arpyxaem kaptomky B Moodle - HacTpoiikn

HasgaHue

File location

Wma daitna

Do6aeuts onpoc (3)

Otobpaxenune

Output format (3)

Navigation (3)

MpuHyAUTENEHBIE MeANa NnaruHLl (3)
Student feedback (@)

Show next quiz (@)

Koutpone goctyna

Hauano Tectuposanua (3

OkoHuaHKe TeCTMpPOBaHUA ®

Heobxogum napons @
Heobxoaum cetesoit agpec @

Paspeluuts npocMoTp nonsitok (3)
Konuuecteo noneitok (3)

OueHku

MeToa oueHusanna (3)

Get from quiz ~

Qaiinel kypca v
Hot Potatoes/jobs multiple choice.htm
[Buﬁparb UnK 3arpyauTs hain .. l

Her +

best v

Moodle navigation bar v
Her «

Huuero v

Her +

5 v ceHmGpa v 2010 v 16 v 00 v [C]Omknouuts
20 ~ centabpa v 2010 v 16 v 00 v [l Omknwounts

flla ~

iCpeaHAn OLUgHKA | v

l | loKka3aTtb A0NONHUTENbHbIE J




'Hot Potatoes B kypce Moodle

. Education in the UK

In this module we
o learn about higher education in the UK

Yg) Higher education in Great Britain (types of universities)
[Z) Higher education in Great Britain - glossary
[l Education in UK

o read more about teaching and exams
|8 supplementary Reading - Education in the UK-link toa web-site
[L] Forms of teaching and examinations

o revise grammar - the Gerund
@) Gerund - grammar review
#) Verbs used with the gerund and the infinitive

GERUND OR INFINITIVE?

Higher Education Vocabulary
Education Correct Words

E Cayvalinas 3anucs us 2AOCCOPUR

A lecture is a formal
method of teaching, and,
although there may be
questions, usually at the
end, there is rarely any
discussion, The number of
students attending is
limited only by the size of
the room,

JeSezams caou samecx!

Beczame.

« CceHTROpA 2010 >

Ec Tx Er

(]
ES
w
26

Yr Ilr G5

B 6 e
i
ERB&G o -8
e85 ow
14
o

5
)

Jerexgs cobumest
N Tocfamee K Kype

N o= B Nemoczarem

lonssoaamenu na calime

E (mocnegnue 5 MRKYT)
Nadexbds Kabanena

I Course videos




Hot Potatoes B kypce Moodle
1t BMISTSIAani:Iﬁ.lﬁHCfMTY'f -

2010 » Hot Potatocs Quizzcs + Placoment Test

Diagnostic Test

Quiz

You are ghen 35 samances which are Incompiete and 4 words or forms marked A, B, C and D. Choose the on2 word or orm thiat D2st s he semence.

Show guestions on2 by one

3.  When I was writing a Jetter, my pen ...




‘ Hot Potatoes B kypce Moodle — «oT9éTH

Tema 4

B

E =0 & DO

<

(e

Higher education in Great Britain (types of
universities)

Higher education in Great Britain - glossary
Education in UK

Supplementary Reading - Education in the UK -
link to a web-site

Forms of teaching and examinations
Gerund - grammar review

Verbs used with the gerund and the infinitive

Verb + gerund vs Verb + infinitive - assignment
GERUND OR INFINITIVE?

My University Studies

My University Studies - Vocabulary
(assignment)
Higher Education Vocabulary

Education Correct Words

Letter to a friend

26 3anHcH

7 3allHCH

QueHKa: -

Hadpaso 6anmos: o,
100, 0

QOueHKa: -

Habpaso 6anios: o,
o

Habpaso danmos: 95,
o

OueHKa: -

BTOPHHK 26 AHBApA 2010, 19:53 (221 JHH 20 )

BTOPHHK 26 AHBApA 2010, 19:51 (221 JHK 20 9)

BTOPHHK 16 MapTa 2010, 13:37 (173 AHHK 2 9)

BTOPHHK 31 aBryCTa 2010, 13:13 (5 AHH 3 H)

BTOPHHK 31 aBT'VCTa 2010, 13:15 (5 ZHK 2 )



‘ Hot Potatoes B kypce Moodle —

SAEMEHT KypCa «TeCT»

Tect  Mmnopt Bonpocoe u3 gaina

( " Berynnesine ;Y/ PeaynbTartsl \’/ ﬂpocmop)g‘;PeAamu poBatb \

TecT Bonpochl KaTteropuu mnopT 3KcnopT
UMnopT Bonpocos u3 daitna 3
®opmar daiina

*@ © Bua npu npoxoxaeHun
©) BnoxeHHble oTBeTHI
©) ®opmart ynpaeneHua TecTUpoBaHnem Kypca
) ®opmar - nponyLyeHHoe CoBo
©) ®opmar Aiken
© ®opmar AON
©) ®opmar Blackboard
) ®opmar Blackboard V6+

") ®opmar GIFT
{©: ®opmar Hot Potatoes

©) ®opmar Learnwise
© ®opmar Moodle XML

©) WebCT-opmar
OcHOBHbIe
Haaganue kateropun (33 Mo ymonuannio ana The Lecturer Of The World (N.A Kabanova) v
Monyunte Kateropun u3 daina V! Monyunte KOHTEKCT U3 daiina
Ecnu oueHka He cooteetcTByeT cnncky  Otobpaante owmbKy v

aonyctumeix (3
_‘ | 3akoHuuTb 06pabotky npu ownbke (@  [da ~




Hot Potatoes B kypce Moodle —

SAEMEHT Kypca «rect - pana jew!!!

T T BUPT MHCTUTYT | [l BKOHTAKTE 171 gmall §J gtrans || SKyNNK 14/ MynsTMTPaH Y dist tug B s e

jo - Momck & Go... % | T7) LW: Umnopr Bonpocos us ¢a... X I KoHcTpykTop MHTEpaKTUBHDI

<~ wupmar T
© ®opmar Hot Potatoes
© ®opmar Leamwise

©) ®opmar Moodle XML
©) WebCT-thopmar

OcHOBHbIE

Mo ymonyanuto Ana The Lecturer Of Th

Hasganue kareropuu (3) :i
Monyuute Kateropum u3 haiina ¥/ Mol

Ecnu ouenka He cooteetctayer cnncky  OtoBpaauTs owwnbky v
Aonyctumbix (3)
3akoHunTe 0bpabotky npu ownbke (3 fa ~

MNOPTHPOEATH W3 (haiina Ha Balem KOMNbITEpe

3arpyaka (MakcumansHbii pasmep: 8Mbaitt)

Wyfnopt uz dpaiina, yxxe umerowerocs B caiinax kypca

Buibepute daitn

MmnoprupoBatk 13 3toro Q)aﬁna]

>
@vﬂ. Pabounii cron »

»

‘ Ynopsgounte ¥ o= Buasl v B Hogan nanka

e T

V136paHHbie ccbliku Vima Pasmep Tun [ata nsmererna &
121103 M6
Ei JokymerTol
S .« Kanbkynaro|
:»_*.Jr HegaeHue mecta L:ng/ ,’-Ipn:g P
Bl Pabounii cron @“ﬁ 1,57 Kb
M Komnetotep ) kpocceopa
" Vsob 4 | Firefox Document
E; 306paxkenna 385Kb
ﬂ Mysbika y Kpoccsopa
(4 HeaaeHo nsmereHH... HotPot)CrossFile
101 Kb B
@ Mowncku =
My3bika - Apabik 1
i e Apnbik T
379 Bair
Flamor el obou - Apabik -
Wma gaiina: kpoccsopa v [Bcemaﬁnu v]
[ OTkpbiTs ] [ OmveHa J

Beibparte unu 3arpyauts daiin ..

ObA3atensHLIe ANA 3aN0NHEHNA NONA B 3T0il opMe nomeyeHs! .

it |
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i |




‘ Hot Potatoes B kypce Moodle —
9AEMEHT KypCa «TeCT»

3 NAE [eCTh Tect  MMnopt BONPOCOB K3 (pauna OBHOBMTL TecT

[ Berynnewme | PeaynbTatel | MpocmoTp ) PenaKTMpoBaTh \
Tect  Bonpocel  Kareropun  Wmnopr  Skcnopr

MonyyeHue BONPOCa M3 MMAOPTMPYEMOrD (aiina

Wmnopt 35 Bonpocos u3 daina

1. ltoften .. in autumn.

2.1fhe ... tomorrow, we will not go to the country.

3. When | was writing a letter, my pen ...

4.] ... to himin a few days.

5.1... the jeans today, because I'm going to the country

6.
When | came home, he _.. dinner.

7.Now | ...what you mean.

8. He said thathe ... help me nexttime.

9.
She was cooking dinner while we ... TV.

I 10.1 ... enter the University next year.




‘ Hot Potatoes B kypce Moodle —
9AEMEHT KyPCa «TECT»

EJ sconrakre ™M gmail &3 gtrans || s & Npocmorp Diagnostic Test (1) - Mozilla Firefox C=auE
11 LW: Pepakimposats Bonpocsl X l ( h { http://met.iml.pu.ru/question/preview.php?continue=18.quizid=87 &id=582 o7
Cos3aath HOBbIM BONpoC BuiOpaTth...
NMpocmoTp Diagnostic Test (1)
N — Tecr: Tect
Nencrene
S Di 1 Itoften ... in autumn.
P = Di Bannos:
-1 Buibepute () a.israining

agaex [ . OOMH OTBET. ) )
s X Di: ® b. rain
agdx [ Di @ c. will rain
agax [ D @ d.rains
a£ix [ Di
agex [ D
o x [ Di
agidx [ D
agd X Di [O‘rnpaaurb crpaHuu,y] [O'rnpasmb BCE W 33BEPWNTL Tecr]

Di
2:: : E Di [OToﬁpasmb omeru] [Hauarb 3aHOBo] [3aKpblTb npocmorp]
agdx [ Dig [ @ OokymeHTauua Moodle gna 3Tl CTpaHULbI
QX g O Bel z3nm noa weerew Nadezhda Kabanova (Bexon)
QI X D ~
QX = Di _ﬂ_‘l"ﬁ?_"‘_l
QX Di:
a£dx [ Di
agdx [ Di
Boibpatk Bce / YOpaTh BbigeneHune FoToso

C BbIOpaHHbIMK:
[Yp.anmb} [I‘Iepemecmrb B >>] Mo ymonuanuio ana The Lecturer Of The World (N.A.Kabanova) (35)




‘ Hot Potatoes B kypce Moodle —
9AEMEHT KypPCa «TECT»

MET LW  Tectsl T:c‘l’ 2 W"Tm OBHOBWTL TecT
[ Berynnewwe | Pesynetatel | MMpocmotp | Pepaktipoeats
Tect  Bonpochi Kareropun Wmnopr  Skenopr
BOI'IPOCH 3TOro tecrta baHk BONpocos
Mopspgox  # Hassanme Bonpoca Tun  Ouenxa DNeiictene Ha3zBauue kateropuu 10 ymonuaHuio gna The Lecturer Of The World (N.A.Kabanova) (35)
3 % = [ QUE» OToBpaxaTb BONPOCH HAXOAAWMECA B NOAKATErOPHAX
* 3 est(31)  EE ] QUL [T Takke nokaasieats crapsie Bonpocs
* 3 3 Diagnostic Test (33) = [ aQg» [TloroGpaskars copepkaHue Bonpoca e crimcke
®+ 3 4 Diagnostic Test (34) N[ a & . o o s T
s * 5 Diagnostic Test (35) *f . Qs (Sjs:g:gl:ngeay)?onqaww ANA BONPOCOB, 0NyBNMKOBaHHBIX B KoHTeKcTe The Lecturer e Worl
+ 6 Diagnostic Test (5) I f QM )
Wtor: 6 Co3parb HOBbIW BONpoc BuiGparth... - @
MaKcuMansHas oLeHka: 10 @ Crpanyua: (Hasam) 1 2
OpTMPOBATL N0 THNY, HA3B3HWMKD =
[Tl oro6pakats paspenutenn cTpanmy, Aeiictene Hassanne sonpoca Tun
["] oroBpaskaTs ynyuweHHbI MHCTPYMEHT NepeMelleHnA Bonpocos (3 «gsdrx [ Diagnostic Test (28) EE
8 x 0] Diagnostic Test (29) =
Kadx [ Diagnostic Test (3) i
KoL x [ Diagnostic Test (30) =
&Kagdx [ Diagnostic Test (31) i
Kasdx [ Diagnostic Test (32) =
Kasdx [ Diagnostic Test (33) i-
«Kasdx [ Diagnostic Test (34) =
KLagd X ] Diagnostic Test (35) =
Kagdx [ Diagnostic Test (4) =
KoL x [ Diagnostic Test (5) =
«Kagdx [ Diagnostic Test (6) i-
[oToso

:: R % =] 8 @ DY nnan eebunapa - ML... sebuHap hot pot ) LW: PegaktupoBaHm... w2 Mail Ru Arent (1 &x...




‘ Hot Potatoes B kypce Moodle —

SAEMEHT KypCa «TeCT»

14
Bannos: 0/ He can't help me. He knows .... About this subject than I.
BbibepuTe oguH OTBET. ® a. least
@ b. more X
'::‘1 c. most
)  d.less
HesepHo :
bannoe 3a oTeeT: 0/1. [aHHblit oTBET noBnek wrpag 0.1.
24
Bannos: 1/1

... he still working? — No, he left an hour ago.

BbibepuTe oguH OTBET.

(@) a. Was
© b. Does
@ c.lsyf
@  d.Did
BepHo

Bannoe sa oTBeT: 1/1.




[lonib3yeTeck /i Bbi
NHTEPAKTUBHbIMMU
yrpa>xHEHNSIMU B CBOEU
neaarorn4eckou
rnpakTuke?

Ecnin A, o 4JIA HYEIO?




‘ IaTepecHo y3HATh OOABITIE?

« kabanova@bk.ru

= hitp://vkontakte.ru/kabanova na

« http://do.iml.pu.ru

« http://met.iml.pu.ru
——

e-Learning PRO

Accouvauusa e-Learning cneumanmcToB




kabanova@bk.ru




